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Electri-Guide ™ Overview of ACTION Files™
ACTION Files  provides the easiest fastest, and most convenient way to manage and organize files. By enhancing the look and feel of the
standard Open and Save windows that are provided by the Macintosh operating system, ACTION Files provides ease of use and power to
make you more productive.

For more than a dozen years, every standard Macintosh application has opened and saved files using windows that look something like the
one shown below. This was fine for opening a file that was on a floppy disk or a small hard drive, but as storage devices grew in size and
users had more files to manage and organize, this little window could no longer keep up with the needs of users. ACTION Files is the
system enhancement that places all the power you need to manage your files in a single window. This Electri-Guide allows you to
quickly tour the highlights of ACTION Files. For details on any feature, just click on the item and you will be taken to a detailed
explanation. For late breaking product information, please visit our web site at: www.actionutilities.com or to be placed on our mailing list
to receive product information, please send e-mail to:  sales@poweronsw.com

Old Fashioned
Standard Macintosh
Open Window
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Open Window  with ACTION Files Installed

New ACTION Files Menu
Bar Added to Open and
Save Windows

Sort Button Permits
Items to be Sorted by
Selected Header in
Ascending or
Descending Order

Headers for
Viewing and
Sorting Items

Click on Header to Sort
by Selected Criterion

Grow Box
Allows Window
to be Resized
to Display More
Information

Drag Lower
Right Corner of
Window to
Resize and
Display More
Information
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The ACTION Files File Menu Creates New Folder for Storing Document

Opens the Selected Item

Cancels the Open or Save Command

Gets Info About File Size, Creation, Kind, etc.

Permits Label to be Added to Selected File

Rename Selected Item in Open or Save Window

Create a Duplicate of Selected Item

Create an Alias of the Selected File

Permits Item to be Moved to Trash
from Open or Save Window

Permits Powerful Searching on
Multiple Criteria with ACTION Find

Finds Next Found Item

Locates Original
File if Alias is Selected

Displays all Items that were
Found in Latest Search

Moves Up One Folder

Moves Down One Folder

Takes User to Desktop View

Ejects any floppy or other removable media
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ACTION Files Edit Menu

Adds selected item to Favorite
Folder or Document list

Adds selected item to Recent
Folder or Document list

Removes Selected Item from
Recent or Favorite Documents
or Folders List

Copies Path Name to Clipboard
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The ACTION Files View Menu

Sort by Name in Open or Save Window

Sort by Size in Open or Save Window

Sort by Kind in Open or Save Window

Sort by Label in Open or Save Window

Sort by Date in Open or Save Window

Sort by Finder View in Open or Save Window

Turns on Header Display in Standard Open
or Save Window

Display Item Size in Open or Save Window

Display File Kind in Open or Save Window

Display File Label in Open or Save Window

Display File Date in Open or Save Window

Display Item List in Selected Font in
Open or Save Window

Display Item List in
Selected Font Size in
Open or Save Window
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The ACTION Files Folder Menu

Selects Previous Folder

Selects Next Folder

Navigates to Selected Folder

Navigates to Selected Remote
Volume

Navigates to Local
Hard Drives

Folders can be designated as
Favorites to ensure they appear
permanently (Note Diamond in front
of Folder Name)
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ACTION Files Documents Menu
Documents Menu shows
Recent Files and Favorite Files

Selecting an
Item in
Documents
Menu Opens it
in Current
Application

Favorite Files
can be Marked
with Diamonds,
Bullets, etc.
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ACTION Files Finder Menu

View Contents of
Any Open Window
in the Finder
With One Click

Tabbed Windows are
Displayed in Finder Menu

View List of All Items on
Desktop by Clicking Outside
of Dialog Box on Desktop

Click on Open Finder
Windows, including
Tabbed Windows, to
View Contents in List
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ACTION Files Drive Menu
ACTION Files adds a popup
menu on the drive icon for
quick, convenient navigation to
all available drives

Selecting this item  takes
you to the Parent volume

Takes you to the previously
selected volume

Takes you to the next volume

Select from any
available volume with a
single click
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ACTION Files Control Panel

Allows customization to ensure
maximum reliability even within
non--standard applications

Configure number of favorite items and
recent items to be tracked by application
currently in use as well as other applications.

Permits user to set default
sorting preferences

Settings for optimization and
display preferences

Item display preferences
for application’s Open and
Save Commands
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Copyright

This manual and software described in it are copyrighted, with all rights reserved. Under the
copyright laws, this manual or the software may not be copied, in whole or in part, without
written consent of Power On Software, Inc., except in the normal use of the software or to make a
backup copy of the software. The same proprietary and copyright notices must be affixed to any
permitted copies as were affixed to the original. Copies may not be made for others, whether or
not sold. Under the law, copying also includes translating into another language or format.

©1998 by Power On Software, Inc.
2046 Lakewood Road SW
Sherrodsville, OH  44675
Voice: (330) 735-3116
Fax: (330) 735-3136
Support: (503) 968-6469

Visit us at our web sites at:

www.actionutilities.com   and   www.poweronsw.com

Software License and Warranty

Power On Software, Inc. grants you the right to use the Software licensed hereunder on the
number of computers specified on the ACTION Files disk delivered as part of this package.

Power On Software, Inc. warrants that the disk on which this software is recorded is free from
defects in material and workmanship, under normal use for one year after the date of original
purchase. If a defect occurs during the one-year period, you may return the disk to Power On
Software, Inc. for a free replacement. POWER ON SOFTWARE, INC. SHALL NOT BE LIABLE FOR ANY
DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF PROFIT, AND SPECIAL, INCIDENTAL, OR
SIMILAR CLAIMS. THE SOFTWARE LICENSED IS DELIVERED ON AN “AS IS” BASIS. EXCEPT FOR THE
EXPRESS WARRANTY SET FORTH ABOVE, POWER ON SOFTWARE, INC. MAKES NO OTHER
WARRANTIES, EITHER EXPRESS OR IMPLIED, BY STATUTE OR OTHERWISE, REGARDING THE
ENCLOSED COMPUTER SOFTWARE PRODUCT, ITS QUALITY, ITS PERFORMANCE, ITS
MERCHANTABILITY, OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

ACTION Utilities™ and ACTION Files™ are trademarks of Power On Software, Inc.

www.actionutilities.com
www.poweronsw.com
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Chapter 1
Introducing ACTION Files

ACTION Files Features

Congratulations! You have in your possession the fastest, easiest, most convenient
way to manage and organize files. ACTION Files enhances the look and feel of the
standard Open and Save windows that are provided by the Macintosh operating
system. It does this by adding several features to make you more productive.
For more than a dozen years, every standard Macintosh application has opened
and saved files using windows that look something like the one shown below in
Figure 1.

Figure 1. Standard Open dialog without ACTION Files installed.

ACTION Files transforms Open and Save windows by adding powerful file
management functions that work automatically with all your applications. Figure 2
shows the same Open dialog with ACTION Files installed. Notice how much more
information and convenience ACTION Files gives you.
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Figure 2. Standard Open dialog with ACTION Files installed.

ACTION Files is designed to ease the task of opening and saving documents with
commands that save you time and effort. ACTION Files gives you:

• Instant access to powerful file management commands through a menu bar at
the top of the Open and Save windows.

• Additional columns containing information about each file, including a file’s
size, date, label, and kind.

• The ability to sort the list by name, size, date, kind, and label in either
ascending or descending order.

• Moveable and resizable Open and Save dialogs to take advantage of larger
monitors.

• A convenient Find command to find files quickly and easily. Search by name,
size, kind, label, creation date, modification date, file type, creator and more.
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• Access to file management commands which allow you to get more
information, create new folders, make an alias or duplicate any file, or move
any file to the trash without leaving the Open or Save dialog.

• Menus which give you access to frequently used and Favorite items.

• Extensive keyboard navigation and command keys for faster access to
commands and files.

You will no longer need to waste time clicking your way through long lists of files
trying to find a particular version of a file. Misplacing that favorite file will never be
a problem again. Now that you have ACTION Files, you can take advantage of the
most effective way to find and organize your work. Get ready for ACTION!
ACTION Files User’s Guide    3

Technical Support

Power On Software is dedicated to providing you the best support possible. Before
contacting us for technical support, please read this manual. See the
Troubleshooting section at the end of the manual for information on how to reach
our technical support staff. If you are still unable to find an answer to your question,
please be in front of your computer when you call technical support.
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Chapter 2
Installing ACTION Files

Getting started

To install ACTION Files on your Macintosh, you will need a color-capable Macintosh
computer (any Macintosh except Macintosh Plus, Macintosh SE, or PowerBook 100
models) and System 7.5 or later. ACTION Files is compatible with all system versions
later than System 7.5, including Mac OS 8 and 8.1.

◊ Note  To determine the version of the system that you are running, use the “About
This Macintosh” command in the Finder’s Apple menu.

This manual assumes that you have a basic grasp of Macintosh skills, including
clicking, dragging, launching applications, opening documents, and saving
documents. If you need help with any of these concepts, consult the “Macintosh
User’s Guide” that came with your Macintosh computer.

Using the installer program

The ACTION Files package consists of several components that need to be loaded
onto your system. The ACTION Files Installer application is designed to place all the
files needed to run ACTION Files in the correct locations. The ACTION Files installer
also provides commands for removing ACTION Files from your system.

To install the software:

1. Restart your computer with extensions disabled by holding down the shift key
while restarting.

2. Insert the ACTION Files floppy disk into the computer.

3. Launch the “ACTION Files Installer” application by double clicking its icon or
by selecting its icon and choosing Open from the File menu.

Figure 3. Launch this application to install ACTION Files.
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4. When the Installer launches, it displays the information dialog shown below in
Figure 4. Please read the text of the copyright and software license. If you do
not accept these terms, click the Decline button and the installer will quit
without modifying your hard drive. You can print the information by clicking
the Print… button and save the information to a file by clicking the Save As…
button. Click the Accept button to continue.

Figure 4. License and warranty dialog for the Installer.

5. After clicking the Accept button, the dialog shown in Figure 5 is displayed. Use
the popup at the top of the window to select whether to perform an easy
install, a customized install, or remove ACTION Files. If you select the Easy
Install method, the window shown in Figure 5 will be visible. You should also
make certain you have adequate disk space as shown in the installer
window.
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Figure 5. Using the Easy Install feature.

6. Click the Switch Disk button to select the destination hard drive. Figure 5 shows
the software being installed on the disk titled “Hard Disk”. If you are not
permitted to install software on the selected disk, then the Install button is
dimmed.

7. Click the Install button to copy the selected software to the hard disk.

8. After the software has been installed, a dialog will appear that lets you enter a
serial number or select to have a demonstration installed. After you enter a
valid serial number, the OK button will be enabled. Press the Demo button to
install a demonstration version of the software.
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Figure 6. Registration dialog for the Installer.

9. After you have selected Demo or entered your serial number, you will be
asked if you want to continue installing software to other disks, or to restart
your computer. Click Continue to install the software on other hard disks.
When you are done, click the Restart button to restart your computer.

If you want to customize the ACTION Files installation, use the popup in the top left
corner of the installer’s window to select the Custom install option. The window
shown in Figure 7 will be displayed.
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Figure 7. Using the Custom Install feature.

The checkbox to the left of the item name indicates whether you will install that
item or not. Click the checkbox to toggle this value. Clicking the icon to the right of
the item name will give you information about the item, as shown in Figure 8.

Figure 8. Information displayed for an ACTION Files installation item.
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Removing ACTION Files

If you want to remove ACTION Files, launch the installer application. When you get
to the main window, use the popup at the top left of the window and choose the
Remove menu item. The window shown in Figure 9 will be displayed. Use the
Switch Disk button to select the hard disk that you want to remove the software
from. Click the Remove button to remove all ACTION Files component files from
your system.

Figure 9. Removing ACTION Files.



Chapter 3
Using ACTION Files
Changes to the Standard File Dialogs

ACTION Files enhances the Open and Save dialogs of the Macintosh operating
system. The first thing you will notice when you install ACTION Files is that there is a
menu of commands that appears at the top of every Open and Save dialog. These
commands, described in further detail later in this chapter, give you access to the
features of ACTION Files.

Figure 10. Standard Save Window with ACTION Files installed.

The second thing you will notice is the features added to the list in the dialogs.
Instead of just showing the name and icon of the file, ACTION Files gives you the
option of displaying the size, date, label, and kind for each file. To ensure that you
can see all the relevant information for each file, a horizontal scroll bar is added to
the bottom of the list, letting you scroll left and right to see all the columns. In
addition, a resize box is placed at the bottom right corner of the list. This resize box
lets you resize the list, and the size of the dialog is appropriately adjusted, still
leaving room for all the other buttons and information in the dialog.
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Figure 11. Standard Save dialog expanded with ACTION Files.
Resizing the Open and Save Dialogs

You can resize the Open and Save dialogs by clicking and dragging the resize icon
at the bottom right corner of the list. You can also resize the dialog by placing the
cursor at the bottom right corner of the dialog itself, then clicking and dragging.
Resizing is done in one of two modes: normal and centered. In normal resizing, only
the bottom and right sides of the dialog are reposition. In centered resizing, the size
of the dialog changes and the position of the dialog is maintained at the center of
the current screen.
Sorting the List in the Open and Save Dialogs

The column headers in the list can be used to sort the columns in the list. By clicking
on the column header for a particular column, the list will be sorted by that
ACTION Files User’s Guide    11



column. The pyramid icon at the top right of the list can be used to switch the sort
order from ascending to descending. You can also use the View menu to change
the sort order of the list. See the section below on the View menu for more
information.
Selecting a Hard Drive

By clicking on the drive icon or name at the top right of the Open or Save dialog,
you can display a popup menu that allows you to go to the parent directory, go to
the previous or next hard drive, or go directly to a specific hard drive. Figure 12
below shows the drive menu.
Figure 12. Changing drives with the drive menu.
Recent and Favorite Items

The menus provided by ACTION Files contain Recent and Favorite items that help
you access the documents you use the most frequently. These items appear in the
ACTION Files Folders and Documents menus, as well as in the hierarchical menus
provided to applications’ Open and Save As menus.
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The term Recent items refers to documents that you have accessed with the current
application, or folders that you have accessed with any application. Recent items
will be added to the ACTION Files menus automatically as you access files and
folders with any application. You can remove a Recent item from any of the
ACTION Files menus by highlighting the item in the menu and pressing the delete
key. The name of the item will be drawn in a strikethrough font and will remain in
the menu until the next time an Open or Save dialog is used or an Open or Save As
menu item is accessed. There is also a Remove as Recent command available in
the ACTION Files Edit menu. See the section below on the Edit menu for more
details.

The term Favorite item refers to items that you have specifically marked to always
be available in the ACTION Files menus. You can specify that a particular file or
folder will always be in these menus by making it a Favorite item. A Favorite item
will be displayed with a special character (a diamond, a bullet, or a triangle)
preceding the name of the item, or the Favorite item can be drawn in a special
style. You can specify the character or the style in the ACTION Files panels of the
ACTION Utilities control panel. See the section on the Menus Panel in the chapter
titled ACTION Utilities Control Panel for more information.

There are two ways to make an item a Favorite item. First, in any of the menus that
list Recent items, you can highlight the name of the item and press the space bar to
make it a Favorite item. If the item is already a Favorite, highlighting the item and
again pressing the space bar will remove its Favorite status. The second way to
make an item a Favorite item is to select the item in an Open or Save dialog and
use the Add As Favorite menu command in ACTION Files’ Edit menu. A Remove As
Favorite menu command is also available. See the section below on the Edit menu
for more details.
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ACTION Files Menus

Many of the features of ACTION Files are accessed through the menus placed at
the top of the dialogs. The menus available are File, Edit, View, Folders, Documents,
and Finder. Each of these menus is described in detail in the following sections.

File Menu

The File menu in ACTION Files gives you access to several commands that allow
you to get and change information about files and folders, duplicate files, perform
searches, navigate through directories, and more.



Figure 13. File menu.
New Folder

Use the New Folder Command to create a new folder in the current directory that is
displayed in the standard file dialog. Using this command brings up a dialog that
lets you choose the name of the new folder. If the name is not unique, an error
message will be displayed, and you will be given a chance to choose another
name.
Open/Save

The second command in the menu changes whether you are using an Open or
Save dialog. This command performs the action that is specified by the default
button in the dialog, namely the Open command in an Open dialog and the Save
command in a Save dialog.
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Cancel

This command performs the Cancel command and is the same as clicking the
Cancel command in the standard file dialog.
Get Info…

This command performs a command similar to the Get Info command that is
provided by the Finder. A separate dialog is displayed that shows information
about the file, including the file’s icon, name, kind, size on disk, creation and
modification date, and locked status. Clicking the Done button closes the dialog
and returns you to the standard file dialog.

Figure 14. Get Info window.
Label

The Label command is a hierarchical menu that displays the currently available
labels as assigned in the Finder, and a checkmark is placed next to the label that is
currently assigned to the file. Selecting an item in this submenu will change the
label for the file to the label you select. It will change the label for this file in the
Finder as well.
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Figure 15. Label menu.
Rename

The Rename command allows you to select a new name for the file or folder that is
currently selected in the standard file dialog. When you select the Rename
command, a dialog box appears that allows you to enter the new name for the file.
If the name you select is already taken by another item in the same directory, a
dialog box will appear that notifies you that the name is already used.
Duplicate

The Duplicate command makes a duplicate of the file or folder that is currently
selected in the standard file dialog. When you select the Duplicate command, a
dialog box appears that allows you to name the new item. The duplicate of the
item is placed in the same directory as the original item. If you choose a file name
that already exists in the current directory, you will be asked if you want to replace
the item with the same name or cancel and choose a different name.
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Make Alias

The Make Alias command makes an alias of the file or folder that is currently
selected in the standard file dialog. When you select the Make Alias command, a
dialog box appears that allows you to name the alias file. The alias of the item is
placed in the same directory as the original item. If you choose a file name that
already exists in the current directory, you will be asked if you want to replace the
item with the same name or cancel and choose a different name.
Move To Trash

The Move To Trash command moves the file or folder that is currently selected in
the standard file dialog to the trash. The file will not, however, be deleted in the
Finder until you choose to empty the trash.
Find

The Find command displays a dialog that allows you to perform a search of all the
files on the disks that are currently connected to the computer. Various search
criteria are available. The results of the search are displayed in the standard file
dialog.

The Find dialog lets you select where you want to search and what search criteria
you want to use. Click the More Choices button to add a criterion, or the Fewer
Choices button to remove the criterion at the bottom of the list. Click the Find button
to perform the find, or the Cancel button to exit the Find dialog.

Figure 16. Find window.
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◊ Note  The number of files displayed as the result of a search may be less than the
number of files that match the search criteria. Only files that can be opened by the
current application will be displayed after a search has been performed; files that
the application cannot open will be filtered out.

The menu at the top of the Find dialog lets you select where you want to search.
These options include on all disks, on local disks, on hard drives, on mounted
servers, on the desktop, only in the folder that is currently displayed in the standard
file dialog, or on any individual disk connected to your computer. Selecting an item
in the popup positions the popup to that item.

Figure 17. Selecting the search location.

The popup menu at the far left of the Find dialog lets you select the criteria you
want to use in the search. The options available are shown in Figure 18 below.

Figure 18. Selecting the search criterion.

The popup menu in the middle of the Find dialog lets you specify how the criteria is
to be used in the search. This popup menu will change depending upon the
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criteria. As an example, the popup menu below shows the options for searching by
any criteria that is a text string, such as the file name.

Figure 19. Selecting how a text-based criterion will be used.

Once the Find button has been clicked, the search is performed and the results are
displayed in the standard file dialog as shown in Figure 20.

Figure 20. Displaying the results of the search.

The results of the search are displayed in the top of the list. Clicking on an item in
the top of the list will result in the path to the file being displayed in the bottom of
the list. Double-clicking on any disk or folder in the bottom part of the list will
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position the standard file dialog to that disk or folder. Clicking and dragging the bar
that has the arrows on it between the two sections of the list will resize the sections
of the list relative to each other.

The number of items that is displayed in the dialog after a search has been
performed may be less than the number of items actually found in the search. For
example, if the search resulted in a match of 100 documents and 10 folders, but
only 10 of the documents can be opened by the current application, then only 20
items will be displayed: the 10 that can be opened by the application plus the 10
folders that matched the query.
Find Next

Once you have found an item and have used the Show Original command to find it
in its original location, you can use the Find Next command to find the next item in
the found list in its original location.
Show Original

The Show Original command is available for any alias that is selected in the list or
for any item that is the result of a Find command. When performed on an alias, the
command will position the dialog at the item that the alias originated from. When
performed on an item in a found list, the list will be positioned at the item’s folder on
the disk and the item will be highlighted.
Goto Found Items/Return From Found Items

After a Find command has been performed, you can use the Return From Found
Items command to return you to the last folder you had the list positioned at before
you performed the Find command. Once you return to any folder after a Find
command has been performed, you can use the Goto Found Items to return to the
results of the last Find command.
Up Level

The Up Level command positions the list up one level in the file directory hierarchy.
This command is not available when the list is positioned at the desktop folder.
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Down Level

The Down Level command positions the list into the currently selected folder. This
command is only available when the currently selected item in the list is a folder or
disk drive.
Desktop

The Desktop command positions the list to the Desktop Folder.
Eject

The Eject command will eject the currently selected ejectable disk, such as a floppy
disk, CD-ROM, optical, Syquest®, Zip® or Jaz® cartridge. This command is not
available if the list is positioned to an item that is not on an ejectable medium.
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Edit Menu

The Edit Menu is used to perform the following commands: Undo, Cut, Copy, Paste,
Add or Remove an item as a Favorite or Recent item, and Copy Path Name of the
current file to the clipboard.

Figure 21. Edit menu.
The third section of the menu lets you add the selected item to the Folders or
Documents menu as a Favorite item or a Recent item. You can also remove the
selected item if it is either a Recent item or a Favorite item in either menu. If the item
is a Favorite item and you remove it as a Favorite item, it still may appear in the
Menus as a Recent item if it has been recently accessed by an application.
Copying the path name to the clipboard will create a text string that contains the
name of each folder in the hierarchy that leads to the current folder displayed in
the list, separated by a colon. For example, an item in a folder called “Work Files” in
a folder called “Documents” on a hard disk called “Hard Disk” would have a path
name of “Hard Disk:Documents:Work Files:”.
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View Menu

The View menu allows you to customize the list that is displayed in the standard file
dialog. The first six items allow you to specify how you want the list to be sorted.
You can sort the list by name, size, kind, label, date, or by Finder View. If you
choose to sort the list by Finder View, the list will be sorted in the same manner that
you have selected for displaying the current folder in the Finder. For example, if
you have a window for a folder sorted by Date Modified in the Finder, that folder
will be sorted by Date Modified in the Open or Save dialog.

Figure 22. View menu.

The center section of the View menu allows you to specify what columns are
displayed in the list. Enabling the Show Header menu item displays the column
names at the top of the list and lets you click on the name of the column to select
which column is to be used to sort the list. Clicking on the pyramid at the top right
corner of the list permits you to change the sort order from ascending to
descending. For text, this will sort from A to Z (ascending) or Z to A (descending). For
dates, you can sort from most recent to oldest (descending) or oldest to most recent
(ascending). You can also sort by size from smallest to largest (ascending) or largest
to smallest (descending). The other menu items in this list let you show or hide the
size, kind, label, and date columns.
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◊ Note  You can still sort by a particular file attribute even though that attribute
may not be displayed in the list. For example, you can sort by size even if the size
column is not displayed in the list.

The last two items in the list allow you to select the font and size of the text that is
used to display the list.
Folders Menu

The Folders menu displays Recent and Favorite folders. When you open a
document from or save a document to a folder, the folder is added to the Folders
menu. This list also contains folders that you specify as Favorite folders that will
always be available in the Folders menu. See the section titled Recent and Favorite
Items at the beginning of this chapter for information on Recent and Favorite items.

Figure 23. Folders menu.
Documents Menu

The Documents menu contains Recent and Favorite documents. Whenever you
open or save a document, it is added to the Documents menu as a Recent item.
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The Documents menu is only available in Open dialogs. The menu also contains
documents that you specify as being Favorite documents that will always be
available in the menu. See the section titled Recent and Favorite Items at the
beginning of this chapter for information on Recent and Favorite items.

◊ Note  Only Recent and Favorite documents that can be opened by the current
application will be displayed in the Documents menu.

Figure 24. Documents menu.
Finder Menu

The Finder Menu is used to open or close the folder currently selected in the list in
the Finder, or to position the list to any folder whose window is open in the Finder.
The first section of the menu allows you to open or close the specified folder in the
Finder, and the second section allows you to position the dialog to an open window
in the Finder. Note that the icon for the folder in the menu can be a normal window
icon, which means that the window is open on the Desktop, or a tabbed window
icon, which means that under Mac OS 8 or later, the window is a tabbed window
that you have placed at the bottom of your desktop.
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Figure 25. Finder menu.
Positioning the List to an Open Window in the Finder

If you can view an open window in the Finder and you are currently in a standard
file dialog, you can click anywhere in that window, and the list in the standard file
dialog will be positioned to the folder.
Enhancements to Open and Save As Menus in Applications

For any application that has a menu item titled “Open” or “Save As”, ACTION Files
can turn that menu into a hierarchical menu as shown in Figure 26. This
hierarchical menu gives you access to Recent and Favorite documents and folders
for the Open menu, and Recent and Favorite folders for the Save As menu.
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Figure 26. The Open hierarchical menu.

The first item in the hierarchical menu is the command that was originally in the
applications menu. Selecting this menu item displays the Open or Save dialog. For
the Open menu item, the second section in the menu displays Recent and Favorite
documents that can be opened by the current application. Clicking on any of these
documents opens the document directly without displaying the Open dialog. The
last section displays Recent and Favorite folders. Selecting one of these folders will
display the Open or Save dialog with its list positioned to the folder whose menu
item was selected.

◊ Note  Only Recent and Favorite documents that can be opened by the current
application will be displayed in the Open hierarchical menu.

The items that are displayed in the hierarchical menu follow the same rules as the
items that are displayed in ACTION Files’ Folders and Documents menus. For more
information, see the section at the beginning of this chapter called Recent and
Favorite Items. The number of items that will be displayed will follow the same
parameters as the standard file dialogs; these can be specified in the Menus panel
of the ACTION Utilities Control Panel.

You can disable the hierarchical menu for these menu items in the Menus panel of
the ACTION Utilities Control Panel. You can also disable the Open hierarchical
menu only if the application already has a menu item called “Open Recent.” See
the section on the Menus panel in the chapter titled Configuring ACTION Files for
more information.

ACTION Files does not currently extend the Open menu for some applications that
do not use Apple’s standard menu code.
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Rebounding to the last item accessed

The ACTION Files rebounding feature is designed to return the list in an Open or
Save dialog to a recently accessed folder, the Documents folder, or the folder
containing the current application. The rebounding feature of ACTION Files works
in conjunction with the rebounding feature that is provided by the General Controls
control panel in System 7.5 and later. If you have the General Controls option set to
rebound to a specific folder, such as the Documents folder or the folder containing
the application, ACTION Files will also rebound to that folder. If you have it set to
rebound to the last folder accessed by the application, it will rebound to the last
accessed folder.

In an Open dialog, the ACTION Files rebounding feature will also reselect the last
item in the specified folder that was accessed from any Open or Save dialog by
that application. The list will automatically be scrolled to that item when the Open
dialog is first displayed and the item will be selected.

To disable the ACTION Files rebounding feature, see the section on the List panel in
the chapter on the ACTION Utilities Control panel.
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Temporarily Disabling ACTION Files

If you want to temporarily disable ACTION Files for any Open or Save dialog, hold
down the Control key while selecting the Open or Save As menu item.
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Chapter 4
Configuring ACTION Files

The ACTION Utilities Control Panel

ACTION Files is a member of the ACTION Utilities family of utility products. The
ACTION Utilities Control Panel is used to configure all the ACTION Utilities
components. If more than one component is installed on your computer, the icons
for the components appear at the bottom of the control panel. Clicking on the icon
for a specific utility displays the configuration panels for that utility. If only one
component is installed, its configuration panels are automatically displayed when
you open the control panel. Clicking on the arrows on the left and right sides of the
icon area will scroll the icons so that you can view all available icons .

Figure 27. The ACTION Utilities Control Panel.
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ACTION Files Configuration Panels

Using the ACTION Utilities Control Panel, you can customize various features of
ACTION Files. Four panels are available in the ACTION Files control panel: Intro,
Menus, List, and Compatibility. The Intro panel contains information about ACTION
Files. The Menus panel lets you customize various features of the menus provided
by ACTION Files. The List panel lets you customize features of the ACTION Files list
and window. The Compatibility panel lets you turn ACTION Files off or disable its
resize feature for specific applications that you choose.

Intro Panel

The Intro panel lets you view information about ACTION Files. Click the About
button to display information about ACTION Files and Power On Software.

Figure 28. Intro panel.



Turning ACTION Files On or Off

Click the On/Off button to enable or disable ACTION Files. You do not need to
restart your computer for this feature to take effect; it takes effect immediately.

Registering a Demo Version of ACTION Files

If you are running a demo version of ACTION Files and have purchased the product
and obtained a valid serial number, or if you have received a new serial number
because you have purchased a site license, you do not need to reinstall the
ACTION Files software to enter your serial number. Simply press the Register button
in the Intro panel, and a registration dialog will appear that will allow you to enter
your name, organization, and serial number. You do not need to restart your
computer for the serialization to take effect.

Menus Panel

The Menus panel lets you customize how ACTION Files displays the Folders and
Documents menus, and also the hierarchical menus that are added to an
application’s Open and Save As menu items.
Limits on Items in the Folders and Documents Menus

The top section in the panel allows you to specify how many items will appear in
the Folders and Documents menus in the standard Open and Save dialogs, and
also in the hierarchical Open and Save As menus in any application. The first two
lines let you specify how many Favorite items will be displayed in the list that have
been recently opened by the current application and by other applications. The
third and fourth lines let you specify how many items will be displayed that have
been recently opened by the current application and by other applications.
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Figure 29. Menus panel.
Specifying the Sort Order for the Folders and Documents Menus

The Sort Folders and Documents section of the Menus panel lets you specify how
the Folders and Documents menus will be sorted. You can select up to three
different sort criteria. You can sort by any of the categories that are specified in the
menu in Figure 30 below.

Figure 30. Sorting categories for displaying items in the menus.
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Clicking on the Defaults button in this panel will return all of the menus used for
sorting the items in the menus to the predefined defaults. These are first by
Application Used, second by Favorite, and third by Date Used. That way all of the
files created by the current application are displayed first, then all your Favorite
items are displayed before any others, and the files you used recently are
displayed before others not used as recently.
Specifying the Icon Mode for the Folders and Documents Menus

The Icon Mode popup lets you select the drawing mode for the icons in the Folders
and Documents menus. You can choose to have normal icons drawn or no icons
drawn at all. Using custom icons will display the icon assigned to the specific folder
or document. The None icon modes may speed up the drawing of these menus on
slower computers.

Figure 31. Icon Mode popup.
Setting the Style for Favorite Items

The Favorites popup lets you select how you want Favorite items to be drawn in the
Folders and Documents menus. A Favorite item is an item that you always want to
have displayed in either of these menus. You can make an item a Favorite item in
the menu by highlighting it then pressing the space bar. An item that is a Favorite
can be displayed as plain text; as text with a bold, italic, underline, outline, or
shadow style; or the menu item can have a dot, diamond, or triangle symbol
before the name of the Favorite.

Figure 32. Favorites popup.
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Specifying File Menu options

The File Menu popup lets you select which items of an application’s File menu will
be extended with the ACTION Files hierarchical menu. This feature optionally adds
a hierarchical menu to any application’s Open or Save As menu item within its file
menu. The choices are to have the hierarchical menu appear in both the Open and
Save As items, only the Open item, only the Save As item, or none of the
application’s menu items. You can also specify that you want the hierarchical
menu to be disabled if the application has a menu item called Open Recent, which
would already fulfill the functionality provided by the ACTION Files hierarchical
menu feature.

Figure 33. File menu popup.
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List Panel

The List panel lets you customize several features of the list of files displayed in an
ACTION Files window.

Figure 34. List Panel.

Specifying How the List is Resized

The first item in the List panel allows you to select how the list and the dialog are
resized. You can select “Standard Resizing” which resizes the list without centering it
in the current screen, or you can select “Center Resizing” which always keeps the list
centered horizontally and vertically within the current screen. If you hold down the
option key while resizing the list, you can use the method of resizing that is not the
current default for resizing.
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Figure 35. Resizing options menu.

Specifying How Icons are Drawn in the List

The second item in the List panel allows you to select how the icons in the list are
drawn. The Normal icons option uses custom icons that each application or file is
assigned by the application, The Generic option uses the simple, generic icons that
are provided by the operating system. Using generic icons is faster and is
recommended for slower computers, or if you are often accessing files across a
network.

Figure 36. Icon drawing mode menu.

Specifying How Dates are Drawn in the List

The third item in the List panel allows you to select how the dates in the list are
drawn. The Long dates option displays the complete day and month names, year,
and time, i.e., “Saturday, December 12, 1998, 1:30:00 PM”. The Abbreviated dates
option displays abbreviated day and month names, the year, and the time, i.e.,
“Sat, Dec 12, 1998, 1:30:00 PM”. The Short dates displays the date in MM/DD/YY
format and the time, i.e., “12/12/98, 1:30:00 PM”.

Figure 37. Date mode menu.

Turning Rebounding On or Off

The fourth item in the List panel allows you to turn on and off the ACTION Files
rebounding feature. The rebounding feature will automatically reselect an item in a
folder that has been recently accessed with the current application via an Open or
Save dialog. See the section on Rebounding to the Last Selected Item in the chapter
Using ACTION Files for more information.



Giving Priority to ACTION Files Command Keys

The fifth item in the List panel allows you to give priority to the command keys in
the ACTION Files menus. If this checkbox is selected, any command keys in conflict
between an application’s Open or Save dialog and the ACTION Files command
keys will result in the ACTION Files command being performed. If this checkbox is
turned off, then the application’s command will be performed. For example,
Microsoft Word uses Command-F to perform its Find command, which is normally
invoked by pressing the Find button in an Open dialog. ACTION Files uses
Command-F to perform the ACTION Files Find menu item. If you have this
checkbox selected, the ACTION Files Find menu item will be selected instead of the
Microsoft Word Find command when Command-F is pressed.
Compatibility Panel

The Compatibility Panel lets you disable ACTION Files completely or just disable the
resize feature of ACTION Files for specific applications that are on your computer’s
disks. To add an application to the list, you click the Add button in the lower left
corner of the panel. Clicking the Add button displays a dialog that lets you select
the application for which you wish to disable ACTION Files. To remove an
application from the list, select the application, then click the Remove button.

The popup at the right of the list lets you specify whether to disable ACTION Files
completely for that application or just to disable the resize feature for that
application.

The first several items in the list may not be selectable. These are applications for
which ACTION Files is permanently disabled due to compatibility reasons.
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Figure 38. Compatibility Panel.
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Chapter 5
Troubleshooting

Technical Support

Power On Software is dedicated to providing you the best support possible. Before
contacting us for technical support, please read this manual, and especially this
chapter on Troubleshooting.

For additional information, you can call our technical support center at (503) 968-
6469. Please have your product serial number ready when you call. You can also
reach us via e-mail at support@actionutilities.com, or visit our Web site,
www.actionutilities.com, which contains tips and tricks, answers to frequently
asked questions, and updates to all the ACTION Utilities products.

◊ Note If you find what you believe is a bug in our product, send email to
bugs@actionutilities.com. Please include a telephone number and/or email address
so that a Quality Assurance representative can contact you.

When contacting us for technical support, please have the following information:

1. Your product registration number as shown on the back of the ACTION Files
installation disk or in the registration information that was emailed to you if
you ordered ACTION Files online.

2. A description of the problem.

3. Information about the Macintosh you are using, including:

a. the model of Macintosh.

b. the System Software version as shown using the About This Macintosh
command in the Apple menu.

c. the amount of Total Memory and the Largest Unused Block as shown using
the About This Macintosh command in the Apple menu.

d. a list of the third party control panels and extensions you are using on your
computer. The Apple System Profile included in System 7.5 and later provides
valuable information.
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Troubleshooting ACTION Files

1. Why don’t the ACTION Files menus appear in a particular standard file dialog?

There are a few reasons that the ACTION Files menu would not appear in a
particular Open or Save dialog window:

a. Using the Compatibility panel in the Control Panel, you may have disabled
ACTION Files for the particular application you are running.

b. There might not have been enough memory to load the ACTION Files menus.

c. ACTION Files may have been turned off using the On/Off button in the Intro
panel of the ACTION Utilities control panel.

d. ACTION Files may have been disabled with an Extensions manager, or the
ACTION Files extension may not have loaded properly when the computer
was started up.

e. A known compatibility issue may exist between ACTION Files and the
application you are using, therefore the ACTION Files software may have
excluded it by default.

2. I know ACTION Files is installed because its menus are being displayed in the
standard file dialog, but the resize box is not being displayed, so I cannot resize
the window. Why?

a. Using the Compatibility panel in the Control Panel, you may have disabled
the ACTION Files resizing feature for the particular application you are
running.

b. A known compatibility issue may exist between ACTION Files and the
application you are using, therefore the ACTION Files software may have
turned the resizing feature off by default.
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